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1 Getting Started

SimPowerSystems Product Description
Model and simulate electrical power systems

SimPowerSystems™ provides component libraries and analysis tools for
modeling and simulating electrical power systems. The libraries offer models
of electrical power components, including three-phase machines, electric
drives, and components for applications such as flexible AC transmission
systems (FACTS) and renewable energy systems. Harmonic analysis,
calculation of total harmonic distortion (THD), load flow, and other key
electrical power system analyses are automated.

SimPowerSystems models can be used to develop control systems and
test system-level performance. You can parameterize your models using
MATLAB® variables and expressions, and design control systems for your
electrical power system in Simulink®. You can add mechanical, hydraulic,
pneumatic, and other components to your model using Simscape™ and test
them together in a single simulation environment. To deploy models to other
simulation environments, including hardware-in-the-loop (HIL) systems,
SimPowerSystems supports C-code generation.

SimPowerSystems was developed in collaboration with Hydro-Québec of
Montreal.

Key Features

• Libraries of application-specific models, including models of common AC
and DC electric drives, flexible AC transmission systems (FACTS), and
renewable energy systems

• Discretization and phasor simulation modes for faster model execution

• Ideal switching algorithm for accelerated simulation of power electronic
devices

• Analysis methods for obtaining state-space representations of circuits and
computing load flow for machines

• Basic models for developing key electrical technologies

• Ability to extend component libraries using the Simscape language

• Support for C-code generation
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SimPowerSystems™ Block Libraries

SimPowerSystems Block Libraries

Overview of SimPowerSystems Libraries
SimPowerSystems libraries contain two top-level block libraries, representing
two different technologies.

Second Generation Libraries
SimPowerSystems Second Generation libraries contain models of typical
power equipment such as transformers, lines, machines, and power
electronics. These models are proven ones coming from textbooks, and
their validity is based on the experience of the Power Systems Testing and
Simulation Laboratory of Hydro-Québec, a large North American utility
located in Canada, and also on the experience of École de Technologie
Supérieure and Université Laval. The capabilities of SimPowerSystems
software for modeling a typical electrical system are illustrated in example
files. And for users who want to refresh their knowledge of power system
theory, there are also self-learning case studies.

The main Second Generation library is called powerlib. It contains
sublibraries of blocks, organized according to their behavior, as well as the
Powergui block that opens a graphical user interface for the steady-state
analysis of electrical circuits.

Third Generation Libraries
SimPowerSystems Third Generation libraries contain Simscape blocks
specifically developed for working with multiphase electrical domains. In
addition to the Simscape Foundation domains, the product contains a
three-phase electrical domain, and you can use this domain to develop your
own custom three-phase blocks with Simscape language. You can also view
and customize source for several machine and transformer example blocks
provided with the product.

The main Third Generation library is called pe_lib. It contains Simscape
blocks with three-phase and single-phase electrical ports, as well as
mechanical rotational and translational ports. These blocks are organized
into sublibraries according to their function. You can connect these blocks
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1 Getting Started

directly to other Simscape blocks, from the Foundation library or from the
other add-on products.

Three-phase electrical ports on Third Generation blocks are collapsed by
default, to support single-line diagrams. You can optionally expand them to
separate the phases, for example, if you need to inject a single-line-to-ground
fault into your circuit.

Using the Simulink Library Browser to Access the
Block Libraries
You can access SimPowerSystems libraries through the Simulink Library
Browser. To display the Library Browser, click the Simulink Library
button in the MATLAB toolstrip, or click the Library Browser button in
the Simulink model window.

Alternatively, you can type simulink in the MATLAB Command Window.
Expand the Simscape entry in the contents tree, then expand the
SimPowerSystems entry.
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Using the Command Prompt to Access the Block
Libraries
Another way to access the block libraries is to open them individually by
using the command prompt:

• To open just the SimPowerSystems Second Generation library, type
powerlib in the MATLAB Command Window.

• To open just the SimPowerSystems Third Generation library, type pe_lib
in the MATLAB Command Window.

• To open the Simscape library (to access the utility blocks, as well as
electrical sources, sensors, and other Foundation library blocks), type
simscape in the MATLAB Command Window.

1-5



1 Getting Started

• To open the main Simulink library (to access generic Simulink blocks), type
simulink in the MATLAB Command Window.

1-6



Comparison of Second and Third Generation Technologies

Comparison of Second and Third Generation Technologies
SimPowerSystems software includes two generations of technology:

• Third Generation technology fully utilizes the Simscape technology and
the component models are written in the Simscape language. You can
directly connect these models with the Simscape Foundation library
components and with components from other add-on products. The Third
Generation technology provides Simscape language source code examples
for machines and transformers, which you can view and customize. The
Third Generation component models are fully compatible with Simscape
technology, including local solver and data logging. Third Generation
technology also provides three-phase electrical connection ports, which you
can individually expand into separate phases as needed. By default, these
three-phase ports are collapsed, to support single-line diagrams.

• Second Generation technology is specialized and optimized for modeling
electrical power systems. The Second Generation technology is mature
and has been refined and tuned for more than a decade. The Second
Generation block libraries contain a large number of models that utilize
their own electrical domain. You connect these blocks to other Simscape
elements ultimately through Simulink signals. The Second Generation
software provides a variety of simulation methods (continuous, discrete,
phasor) and analysis tools.

First Generation technology, utilized in a product called Power System
Blockset™, used Simulink signals for connecting electrical blocks in a
diagram. This product has been replaced by the SimPowerSystems Second
Generation technology, which introduced physical connections between
blocks.
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1 Getting Started

Per-Unit System of Units

In this section...

“What Is the Per-Unit System?” on page 1-8

“Example 1: Three-Phase Transformer” on page 1-10

“Example 2: Asynchronous Machine” on page 1-11

“Base Values for Instantaneous Voltage and Current Waveforms” on page
1-13

“Why Use the Per-Unit System Instead of the Standard SI Units?” on page
1-13

What Is the Per-Unit System?
The per-unit system is widely used in the power system industry to express
values of voltages, currents, powers, and impedances of various power
equipment. It is mainly used for transformers and AC machines.

For a given quantity (voltage, current, power, impedance, torque, etc.) the
per-unit value is the value related to a base quantity.

base value in p.u. = 
quantity expressed in SI units

base vallue

Generally the following two base values are chosen:

• The base power = nominal power of the equipment

• The base voltage = nominal voltage of the equipment

All other base quantities are derived from these two base quantities. Once the
base power and the base voltage are chosen, the base current and the base
impedance are determined by the natural laws of electrical circuits.
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Per-Unit System of Units

base current = 
base power
base voltage

base impedance = 
base  voltage
base current

= 
(base voltage)

base power

2

For a transformer with multiple windings, each having a different nominal
voltage, the same base power is used for all windings (nominal power of the
transformer). However, according to the above definitions, there are as many
base values as windings for voltages, currents, and impedances.

The saturation characteristic of saturable transformer is given in the form
of an instantaneous current versus instantaneous flux-linkage curve: [i1
phi1; i2 phi2; ... , in phin].

When the per-unit system is used to specify the transformer R L parameters,
the flux linkage and current in the saturation characteristic must be also
specified in pu. The corresponding base values are

base instantaneous current = (base rms current)  

base fl

× 2

uux linkage = 
base rms voltage)  

base frequency)
 

(
(

×
×

2
2

where current, voltage, and flux linkage are expressed respectively in volts,
amperes, and volt-seconds.

For AC machines, the torque and speed can be also expressed in pu. The
following base quantities are chosen:

• The base speed = synchronous speed

• The base torque = torque corresponding at base power and synchronous
speed

base torque = 
base power (3 phases) in VA
base speed in radiians/second
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1 Getting Started

Instead of specifying the rotor inertia in kg*m2, you would generally give the
inertia constant H defined as

H = kinetic energy stored in the rotor at synchronous speed iin joules
machine nominal power in VA

H
J w

Pnom
=

× ⋅1
2

2

The inertia constant is expressed in seconds. For large machines, this
constant is around 3 to 5 seconds. An inertia constant of 3 seconds means that
the energy stored in the rotating part could supply the nominal load during 3
seconds. For small machines, H is lower. For example, for a 3 HP motor, it
can be between 0.5 and 0.7 second.

Example 1: Three-Phase Transformer
Consider, for example, a three-phase two-winding transformer. The following
typical parameters could be provided by the manufacturer:

• Nominal power = 300 kVA total for three phases

• Nominal frequency = 60 Hz

• Winding 1: connected in wye, nominal voltage = 25 kV RMS line-to-line

resistance 0.01 pu, leakage reactance = 0.02 pu

• Winding 2: connected in delta, nominal voltage = 600 V RMS line-to-line

resistance 0.01 pu, leakage reactance = 0.02 pu

• Magnetizing losses at nominal voltage in % of nominal current:

Resistive 1%, Inductive 1%

The base values for each single-phase transformer are first calculated:

• For winding 1:

Base power 300 kVA/3 = 100e3 VA/phase

Base voltage 25 kV/sqrt(3) = 14434 V RMS
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Base current 100e3/14434 = 6.928 A RMS

Base impedance 14434/6.928 = 2083 Ω

Base resistance 14434/6.928 = 2083 Ω

Base inductance 2083/(2π*60)= 5.525 H

• For winding 2:

Base power 300 kVA/3 = 100e3 VA

Base voltage 600 V RMS

Base current 100e3/600 = 166.7 A RMS

Base impedance 600/166.7 = 3.60 Ω

Base resistance 600/166.7 = 3.60 Ω

Base inductance 3.60/(2π*60) = 0.009549 H

The values of the winding resistances and leakage inductances expressed in
SI units are therefore

• For winding 1: R1= 0.01 * 2083 = 20.83 Ω; L1= 0.02*5.525 = 0.1105 H

• For winding 2: R2= 0.01 * 3.60 = 0.0360 Ω; L2= 0.02*0.009549 = 0.191 mH

For the magnetizing branch, magnetizing losses of 1% resistive and 1%
inductive mean a magnetizing resistance Rm of 100 pu and a magnetizing
inductance Lm of 100 pu. Therefore, the values expressed in SI units referred
to winding 1 are

• Rm = 100*2083 = 208.3 kΩ

• Lm = 100*5.525 = 552.5 H

Example 2: Asynchronous Machine
Now consider a three-phase four-pole Asynchronous Machine block in SI
units. It is rated 3 HP, 220 V RMS line-to-line, 60 Hz.
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1 Getting Started

The stator and rotor resistance and inductance referred to stator are

• Rs = 0.435 Ω; Ls = 2 mH

• Rr = 0.816 Ω; Lr = 2 mH

The mutual inductance is Lm = 69.31 mH. The rotor inertia is J = 0.089 kg.m2.

The base quantities for one phase are calculated as follows:

Base power 3 HP*746VA/3 = 746 VA/phase

Base voltage 220 V/sqrt(3) = 127.0 V RMS

Base current 746/127.0 = 5.874 A RMS

Base impedance 127.0/5.874 = 21.62 Ω

Base resistance 127.0/5.874 = 21.62 Ω

Base inductance 21.62/(2π*60)= 0.05735 H = 57.35 mH

Base speed 1800 rpm = 1800*(2π)/60 = 188.5 radians/second

Base torque (3-phase) 746*3/188.5 = 11.87 newton-meters

Using the above base values, you can compute the values in per-units.

Rs= 0.435 / 21.62 = 0.0201 pu Ls= 2 / 57.35 = 0.0349 pu

Rr= 0.816 / 21.62 = 0.0377 pu Lr= 2 / 57.35 = 0.0349 pu

Lm = 69.31/57.35 = 1.208 pu

The inertia is calculated from inertia J, synchronous speed, and nominal
power.

H
J w

Pnom
=

× ⋅
=

× ×

×
=

1
2

1
2

0 089 188 5

3 746
0 7065

2 2. ( . )
.  seconds
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If you open the dialog box of the Asynchronous Machine block in pu units
provided in the Machines library of powerlib, you find that the parameters
in pu are the ones calculated above.

Base Values for Instantaneous Voltage and Current
Waveforms
When displaying instantaneous voltage and current waveforms on graphs or
oscilloscopes, you normally consider the peak value of the nominal sinusoidal
voltage as 1 pu. In other words, the base values used for voltage and currents

are the RMS values given above multiplied by 2 .

Why Use the Per-Unit System Instead of the Standard
SI Units?
Here are the main reasons for using the per-unit system:

• When values are expressed in pu, the comparison of electrical quantities
with their "normal" values is straightforward.

For example, a transient voltage reaching a maximum of 1.42 pu indicates
immediately that this voltage exceeds the nominal value by 42%.

• The values of impedances expressed in pu stay fairly constant whatever the
power and voltage ratings.

For example, for all transformers in the 3 kVA to 300 kVA power range,
the leakage reactance varies approximately between 0.01 pu and 0.03
pu, whereas the winding resistances vary between 0.01 pu and 0.005 pu,
whatever the nominal voltage. For transformers in the 300 kVA to 300
MVA range, the leakage reactance varies approximately between 0.03 pu
and 0.12 pu, whereas the winding resistances vary between 0.005 pu and
0.002 pu.

Similarly, for salient pole synchronous machines, the synchronous
reactance Xd is generally between 0.60 and 1.50 pu, whereas the
subtransient reactance X’d is generally between 0.20 and 0.50 pu.

It means that if you do not know the parameters for a 10 kVA transformer,
you are not making a major error by assuming an average value of 0.02 pu
for leakage reactances and 0.0075 pu for winding resistances.
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1 Getting Started

The calculations using the per-unit system are simplified. When all
impedances in a multivoltage power system are expressed on a common power
base and on the nominal voltages of the different subnetworks, the total
impedance in pu seen at one bus is obtained by simply adding all impedances
in pu, without taking into consideration the transformer ratios.
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Modeling Basics

• “Modeling Power Engineering Systems Using SimPowerSystems Third
Generation Software” on page 2-2

• “Essential Power Engineering Modeling Techniques” on page 2-4

• “Three-Phase Ports” on page 2-7

• “Switch Between Physical Signal and Electrical Ports” on page 2-9



2 Modeling Basics

Modeling Power Engineering Systems Using
SimPowerSystems Third Generation Software

In this section...

“SimPowerSystems Third Generation Blocks and Ports” on page 2-2

“Machine and Transformer Source Code Examples” on page 2-3

“Plotting and Display Options for Asynchronous and Synchronous
Machines” on page 2-3

“Choosing the Right SimPowerSystems Technology” on page 2-3

SimPowerSystems Third Generation Blocks and Ports
SimPowerSystems Third Generation blocks are written in the Simscape
language. The blocks are fully compatible with Simscape technology,
including the local solver, code generation, and data logging.

SimPowerSystems Third Generation blocks have composite three-phase,
electrical conserving, and mechanical rotational conserving ports. You can
use composite three-phase ports to build models corresponding to single-line
diagrams of three-phase electrical systems. Composite three-phase ports
connect to other composite three-phase ports. Electrical and mechanical
rotational conserving ports connect directly to Simscape Foundation library
components and Simscape add-on products such as SimElectronics®. You can
use a Phase Splitter block to split a composite three-phase port into individual
electrical conserving ports.

Blocks in the Semiconductors library of SimPowerSystems Third
Generation software have an have an option to switch certain ports between
physical signal and electrical conserving ports. When you select electrical
ports, the semiconductor block has the same ports as the equivalent
semiconductor block in SimElectronics. Therefore, you can easily switch
semiconductor blocks in your model between the two products. For example,
suppose you have used SimPowerSystems Third Generation semiconductor
blocks to model the electronic drive circuit for a three-phase machine but
want to increase the drive circuit fidelity. You can directly replace the
semiconductor blocks with higher-fidelity versions from the SimElectronics
block library.
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Machine and Transformer Source Code Examples
SimPowerSystems Third Generation software comes with Simscape language
source code examples for machines and transformers, which you can view and
customize. To access the example blocks, type ThreePhaseExamples_lib at
the MATLAB command prompt. To see the example blocks in three-phase
electrical models, see Creating Components and Libraries.

Plotting and Display Options for Asynchronous and
Synchronous Machines
For asynchronous and synchronous machine blocks in SimPowerSystems
Third Generation software, you can perform some useful plotting and display
actions using the Power Systems menu on the block context menu. For
example, to plot torque versus speed (both in SI units) for the Asynchronous
Machine Wound Rotor (fundamental) block, right-click the block. From the
context menu, select Power Systems > Asynchronous Machine > Plot
Torque Speed (SI). The software plots the results in a figure window.

Using other options on the Power Systems menu, you can plot values in per
unit or display base parameter values in the MATLAB Command Window.
These options enable you to quickly tune the performance of your three-phase
machine.

Choosing the Right SimPowerSystems Technology
SimPowerSystems™ software includes two generations of technology. For a
comparison of the two technologies, see “Comparison of Second and Third
Generation Technologies” on page 1-7. Choose the SimPowerSystems
technology most appropriate for your modeling needs and if possible, build
your model using blocks exclusively from that technology. However, if
necessary, you can build a model that uses blocks from both technologies.
To do so, use blocks from the Simscape > SimPowerSystems > Second
Generation > Interface Elements library to interface between them.

2-3
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2 Modeling Basics

Essential Power Engineering Modeling Techniques

In this section...

“Overview of Modeling Rules” on page 2-4

“Required Blocks” on page 2-5

Overview of Modeling Rules
SimPowerSystems Third Generation models are essentially Simscape
block diagrams refined for modeling three-phase electrical systems.
SimPowerSystems Third Generation blocks feature these port types:

• Three-phase ports, which connect the phases of a three-phase electrical
system between SimPowerSystems Third Generation blocks.

There are two three-phase port types in SimPowerSystems Third
Generation blocks, composite and expanded. You can connect a composite
three-phase port only to another composite three-phase port. You
can connect the individual electrical conserving ports of an expanded
three-phase port only to other electrical conserving ports. For more
information, see “Three-Phase Ports” on page 2-7.

• Electrical and mechanical rotational conserving ports, which connect
directly to Simscape foundation blocks.

Each port type has specific Across and Through variables associated with
it. To learn about the rules to follow when building an electromechanical
model, see “Basic Principles of Modeling Physical Networks” in the
Simscape documentation.

• Physical signal ports, which connect to Simulink blocks through the
Simulink-PS Converter and PS-Simulink Converter blocks from the
Simscape Utilities library. These blocks convert physical signals to and
from Simulink mathematical signals.

Keep these rules in mind when using each port type in SimPowerSystems
Third Generation blocks.

• You can connect physical conserving ports only to other conserving ports
of the same type. Electrical conserving ports in SimPowerSystems Third
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Generation blocks can connect directly to SimElectronics blocks and
Simscape electrical components. Mechanical rotational conserving ports
in SimPowerSystems Third Generation blocks can connect directly to
Simscape mechanical rotational components.

• The physical connection lines that connect conserving ports are
nondirectional lines that carry physical variables (Across and Though
variables) rather than signals. You cannot connect physical conserving
ports to Simulink ports or to physical signal ports.

• You can branch physical connection lines. When you do so, directly
connected components share the same Across variables. The value of any
Through variable (e.g., current or torque) transferred along the physical
connection line is divided among the multiple components connected by
the branches.

For each Through variable, the sum of the values flowing into a branch
point equals the sum of the values flowing out.

• You can connect physical signal ports to other physical signal ports using
regular connection lines, similar to Simulink signal connections. These
connection lines carry physical signals between SimPowerSystems Third
Generation blocks.

• You can connect physical signal ports to Simulink ports through converter
blocks. Use the Simulink-PS Converter block to connect Simulink outports
to physical signal inports. Use the PS-Simulink Converter block to connect
physical signal outports to Simulink inports.

• Unlike Simulink signals, physical signals can have units. In
SimPowerSystems Third Generation block dialog boxes, you can specify
the units along with the parameter values, where appropriate. Use the
converter blocks to associate units with an input signal and to specify the
desired output signal units.

For an example of these rules applied to an electromechanical model, see
Three-Phase Asynchronous Machine Starting.

Required Blocks
Each topologically distinct physical network in a diagram requires exactly one
Solver Configuration block from the Simscape Utilities library. The Solver
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Configuration block specifies global environment information for simulation
and provides parameters for the solver that your model needs for simulation.

Each electrical network requires an Electrical Reference block. This
block establishes the electrical ground for the circuit. Networks with
electromechanical blocks also require a Mechanical Rotational Reference
block. For more information about using reference blocks, see “Grounding
Rules”.
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Three-Phase Ports

In this section...

“About Three-Phase Ports” on page 2-7

“Expand and Collapse Three-Phase Ports on a Block” on page 2-8

About Three-Phase Ports
In SimPowerSystems Third Generation software, you can connect the phases
of a three-phase system between blocks using two types of port.

• Composite three-phase port

• Expanded three-phase port

Composite three-phase ports represent three individual electrical conserving
ports with a single block port. You can use composite three-phase ports to
build models that correspond to single-line diagrams of three-phase electrical
systems. Instead of explicitly connecting each phase of the three-phase
system between blocks, you connect all three phases using a single port. You
can connect composite three-phase ports only to other composite three-phase
ports.

Expanded three-phase ports represent the individual phases of a three-phase
system using three separate electrical conserving ports. You individually
connect each phase of the three-phase system between blocks. Electrical
conserving ports can connect directly to electrical components from the
Simscape and SimElectronics libraries.

Composite three-phase ports produce results with the same fidelity as
expanded three-phase ports. Both connection methods consider instantaneous
phase voltages and currents and are suitable for modeling balanced and
unbalanced three-phase electrical power systems. Each electrical conserving
port in an expanded three-phase port has a Through variable of scalar current
and an Across variable of scalar voltage. For a composite three-phase port,
the Through variable is a three-element current, and the Across variable
is a three-element voltage.
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You can use the Phase Splitter block to expand a composite three-phase port
into separate electrical conserving ports. The separate electrical ports can
then connect to Simscape and SimElectronics electrical components.

The figure shows two simple circuits that contrast the composite and
expanded connection methods. The two circuits produce the same results.

The top circuit uses a Voltage Source block with a composite three-phase port
~. The bottom circuit uses a Voltage Source block with expanded electrical
conserving ports a, b, and c. In each circuit, the instantaneous phase voltages
and currents are the same.

Expand and Collapse Three-Phase Ports on a Block
SimPowerSystems Third Generation blocks that have composite three-phase
ports have an option to switch between composite and expanded ports.

• Right-click the block. On the Simscape block choices context menu,
select Expanded three-phase ports or Composite three-phase ports.

For blocks with a single composite port ~, the expanded electrical ports are
labeled a, b, and c. For blocks with more than one composite port ~1 and
~2, the expanded electrical ports are labeled a1, b1, c1 and a2, b2, c2.
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Switch Between Physical Signal and Electrical Ports
Some SimPowerSystems Third Generation blocks have an option to switch
certain ports between physical signal and electrical conserving ports. An
electrical conserving port is a Simscape physical conserving port that has
a Through variable of current and an Across variable of voltage. For a
comparison of Simscape physical signal and physical conserving ports, see
“Connector Ports and Connection Lines”.

• Right-click the block. On the Simscape block choices context menu,
select Electrical control port or PS control port.

The block connection port switches between (electrical conserving port)
and (physical signal port).
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Build a Simple Three-Phase Model

In this section...

“Overview of Simple Three-Phase Model Tutorial” on page 3-2

“Select Blocks to Represent System Components” on page 3-2

“Build the Model” on page 3-3

“Specify Model Parameters” on page 3-5

Overview of Simple Three-Phase Model Tutorial
This tutorial shows you how to build a SimPowerSystems Third Generation
model. The model simulates the behavior of a three-phase AC voltage source
driving a simple load.

To build the model, you add blocks from the SimPowerSystems Third
Generation block library as well as Simscape blocks.

To see the completed model, click Simple Three-Phase Model.

Select Blocks to Represent System Components
Select blocks to model input signals and electrical characteristics of the
three-phase system and display system outputs.

This table describes the role of blocks representing the system components.

Block Description

Solver
Configuration

Defines solver settings that apply to all physical
modeling blocks

Voltage Source Ideal three-phase voltage source that maintains
a sinusoidal voltage across its output terminals,
regardless of the current flowing in the source

Phase Voltage
Sensor

Converts the voltage across each phase of
the three-phase system into a physical signal
proportional to that voltage
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Block Description

Current Sensor Converts the electrical current flowing in each
phase of the three-phase load into a physical signal
proportional to that current

RLC Models the resistive, inductive, and capacitive
properties of the three-phase load

PS-Simulink
Converter

Converts a physical signal to a Simulink signal

Scope Displays phase voltages and currents for the
three-phase system

Electrical
Reference

Provides the ground connection for electrical
conserving ports

Grounded Neutral Provides an electrical ground connection for each
phase of the three-phase system

Build the Model

1 Open the Simulink Library Browser.

2 Select File > New > Model.

3 Drag these blocks from the library into your model.

Block Library Path Quantity

Voltage Source Simscape >
SimPowerSystems >
Third Generation >
Sources

1

Phase Voltage
Sensor

Simscape >
SimPowerSystems >
Third Generation >
Sensors

1
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Block Library Path Quantity

Current Sensor Simscape >
SimPowerSystems >
Third Generation >
Sensors

1

RLC Simscape >
SimPowerSystems >
Third Generation >
Passive Devices

1

Electrical
Reference

Simscape > Foundation
Library > Electrical >
Electrical Elements

1

Grounded Neutral Simscape >
SimPowerSystems >
Third Generation >
Connections

2

Solver
Configuration

Simscape > Utilities 1

PS-Simulink
Converter

Simscape > Utilities 2

Scope Simulink > Sinks 1
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4 Connect the blocks as shown.

5 Save the model using the name simplethreephasemodel.

The blocks in this model use composite three-phase ports. For more
information, see “Three-Phase Ports” on page 2-7.

Specify Model Parameters
Specify parameters that model system components and control simulation
behavior. These include:

• Simulation Parameters

• Load Impedance Parameters

• Display Parameters

Simulation Parameters
As with Simscape models, you must include a Solver Configuration block in
each topologically distinct physical network. This model has a single physical
network, so use one Solver Configuration block.
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In the Solver Configuration block:

• Select Use local solver.

• Set Sample time to 0.0001.

In Simscape-based models, the local solver is a sample-based solver
that represents physical network states as discrete states. For most
SimPowerSystems Third Generation models, the local solver is an appropriate
first choice. The solver updates block states once per simulation time step,
as determined by Sample time. For simulation of a 60 Hz AC system, an
appropriate sample time is a value in the order of 1e-4. For more information
on solver options see Solver Configuration.

If you prefer to use a continuous solver instead of a discrete solver, clear the
Use local solver check box in the Solver Configuration block. The simulation
then uses the Simulink solver specified in the model configuration parameters
(Simulation > Model Configuration Parameters). For SimPowerSystems
Third Generation models, an appropriate solver choice is the moderately
stiff solver ode23t. For a 60 Hz AC system, specify a value for Max step
size in the order of 1e-4. For more information, see “Explicit Continuous
Variable-Step Solvers”.

In the Simulink Model Editor, set the simulation stop time to 0.1.

Load Impedance Parameters
The RLC block models resistive, inductive, and capacitive characteristics of
the three-phase load. Using the Component structure parameter, you
can specify a series or parallel combination of resistance, inductance, and
capacitance.

In the RLC block, leave the defaults:

• Component structure is set to R.

• Resistance is set to 1 Ω.

Setting Component structure to R models a three-phase load that is purely
resistive in nature. The resistance in each phase is 1 Ω. “Simulate and
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Analyze a Three-Phase Load Model” on page 3-8 discusses the behavior of a
load with these characteristics.

Display Parameters
Sensor blocks in the model convert the current and voltage in each phase
of the three-phase system to proportional physical signals. PS-Simulink
Converter blocks convert the physical signals into Simulink signals for the
Scope block to display.

Of these three types of block, only the converter blocks have parameters.
For this example:

• Set Output signal unit of the PS-Simulink Converter block to A. This
setting ensures that the block outputs a signal with the same magnitude
as the ampere signal that enters it.

• Set Output signal unit of the PS-Simulink Converter1 block to V. This
setting ensures that the block outputs a signal with the same magnitude
as the voltage signal that enters it.

Label the input signals to the Scope block. Double-click each line, and type
the appropriate label, Currents or Voltages, as shown in the model graphic.

Save the model. You are ready to simulate the model and analyze the results.

Related
Examples

• “Simulate and Analyze a Three-Phase Load Model” on page 3-8
• “Create an Expanded Resistive Three-Phase Load” on page 3-10
• “Create a Reactive Three-Phase Load” on page 3-12
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Simulate and Analyze a Three-Phase Load Model
In “Build a Simple Three-Phase Model” on page 3-2, you built a simple
SimPowerSystems Third Generation model. This procedure shows you how to
run the simulation and plot the results.

1 Simulate the model.

2 View the phase currents and voltages. Double-click the Scope block.

3 Click the Autoscale button to scale the scope axes to the data.

In this example, the Component structure parameter of the RLC block
specifies that the electrical characteristics of the three-phase load are purely
resistive. Therefore, for each phase of the three-phase system, the voltage and
current remain in phase with each other. Because the resistance in each
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phase is 1 Ω, the magnitude of the phase voltage is equal to the magnitude
of the phase current.
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Create an Expanded Resistive Three-Phase Load
This procedure shows you how to modify the model you built in “Build a
Simple Three-Phase Model” on page 3-2 to create:

• A three-phase load expanded into individual phases

• An expanded three-phase load that does not have equal resistance in each
phase

In this procedure, you make changes to the original model and save the
changes as new models. You then simulate each new model and analyze
the results.

1 Open Simple Three-Phase Model.

2 Delete the RLC block.

3 Drag two copies of the Phase Splitter block into the model from the
Simscape > SimPowerSystems > Third Generation > Connections
library.

4 Flip one of the Phase Splitter blocks horizontally. Right click the block and
select Rotate & Flip > Flip Block > Left-Right.

5 Drag a Resistor element into the model from the Simscape > Foundation
Library > Electrical > Electrical Elements library.

6 Hide the Resistor element label to create space for more components.
Right-click the resistor and select Format > Show Block Name to clear
this option.

7 Make two more copies of the Resistor element.

8 Connect the components as shown.
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9 Save this version of the modified model using the name
simplethreephasemodel_expanded_balanced.

This model name reflects that the load previously modeled by the RLC
block is now expanded into individual phases. The load is still balanced,
i.e., there is equal resistance in each phase.

10 Unbalance the load by changing the resistance in one phase. Double-click
one of the resistor elements. Change Resistance to 2.

11 Save this version of the modified model using the name
simplethreephasemodel_expanded_unbalanced.

This model name reflects that the three-phase load previously modeled by
the RLC block is expanded into individual phases. The load is unbalanced,
i.e., the resistance in one of the phases is higher than in the other two.

Related
Examples

• “Simulate a Resistive Three-Phase Load Model” on page 3-13
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Create a Reactive Three-Phase Load
This procedure shows you how to modify the model you built in “Build a
Simple Three-Phase Model” on page 3-2 to create a reactive load. A reactive
load has inductive or capacitive characteristics.

In this procedure, you make changes to the original model and save the
changes as a new model. You then simulate the new model and analyze the
results.

1 Open Simple Three-Phase Model.

2 In the RLC block, set:

• Component structure to Series RL

• Inductance to 0.002

3 Save this version of the model using the name
simplethreephasemodel_reactive.

Related
Examples

• “Simulate a Reactive Three-Phase Load Model” on page 3-16
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Simulate a Resistive Three-Phase Load Model
In “Create an Expanded Resistive Three-Phase Load” on page 3-10, you built
models to extend the basic model completed in “Build a Simple Three-Phase
Model” on page 3-2. In this procedure, you simulate the extended models
and analyze the results.

1 Open the simplethreephasemodel_expanded_balanced model.

2 Simulate the model.

3 View the simulation results. Double-click the Scope block.

4 Click the Autoscale button to scale the scope axes to the data.
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In “Build a Simple Three-Phase Model” on page 3-2, the Component
structure parameter of the RLC block specifies that the three-phase load
is purely resistive. In this version of the model, the load is expanded into
an individual resistive element for each phase, but the resistance in each
phase is unchanged. For each phase of the three-phase system, the voltage
and current remain in phase with each other. Because the resistance
in each phase is 1 Ω, the magnitude of the phase voltage is equal to the
magnitude of the phase current.

Comparing this result with that described in “Simulate and Analyze a
Three-Phase Load Model” on page 3-8 shows that a block with composite
three-phase ports (the RLC block in the original model), produces a result
with the same fidelity as that of expanded phases.

5 Open the simplethreephasemodel_expanded_unbalanced model.

6 Simulate the model. Autoscale the scope axes.

In this version of the model, one phase of the three-phase load has twice
the resistance of the other two. Therefore, half as much current flows in
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that phase, as the second plot shows. However, because the load remains
purely resistive, the voltage and current remain in phase with each other.

3-15



3 Tutorials

Simulate a Reactive Three-Phase Load Model
In “Create a Reactive Three-Phase Load” on page 3-12, you built a model to
extend the basic model completed in “Build a Simple Three-Phase Model” on
page 3-2. In this procedure, you simulate the extended model and analyze
the results.

1 Open the simplethreephasemodel_reactive model.

2 Simulate the model.

3 View the simulation results. Autoscale the scope axes.

4 Examine the results in closer detail. For example, click the Zoom X-axis
button and drag a box over the first third of one of the plots.

In “Build a Simple Three-Phase Model” on page 3-2, the electrical
characteristics of three-phase load are purely resistive. In this model, the
Component structure parameter of the RLC block is set to Series RL,
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meaning that the load has an inductive characteristic. The current flowing
in each phase lags the voltage.
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Machine Parameterization
In SimPowerSystems Third Generation software, asynchronous machines are
parameterized using fundamental parameters. Each synchronous machine is
parameterized using standard or fundamental parameters.

Machine fundamental parameters include the values of inductances and
resistances of the stator and rotor d- and q-axis equivalent circuits. These
parameters fully specify the electrical characteristics of the machine, but
you cannot determine them directly from machine test responses. Hence, it
is more common to parameterize a synchronous machine using a standard
parameter set. You can obtain the standard parameters by observing
responses at the machine’s terminals with suitable tests scenarios.

You can tell the parameter set a block uses because the block name includes
the parameter set name, e.g. Asynchronous Machine Squirrel Cage
(fundamental). The parameters you can set in the block dialog box correspond
to the parameterization type.

If a machine block has a standard and a fundamental variant, base your block
choice on the parameters you are most familiar with or you have available.
When you use a standard block variant in your simulation, the software uses
classical equations to convert the standard parameter values you enter to
fundamental parameter values for use at runtime.

The field circuit and rotational ports of machine blocks use SI units. However,
the pu measurement port of machine blocks outputs a vector of physical
signals in per unit.

Concepts • “Per-Unit System of Units” on page 1-8
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Machine Plotting and Display Options
For some blocks in the Machines sublibrary in SimPowerSystems Third
Generation software, you can perform plotting and display actions using the
Power Systems context menu.

For example, you can plot torque versus speed for the Asynchronous Machine
Wound Rotor block, either in SI or per-unit units. You access these commands
using the Power Systems menu on the block context menu.

Using other options on the Power Systems menu, you can display values
in per unit or display base parameter values in the MATLAB Command
Window. These options enable you to quickly initialize and tune your
three-phase machine.

Asynchronous Machine Options

• Display Base Values displays the machine per-unit base values in the
MATLAB Command Window.

• Plot Torque Speed (SI) plots torque versus speed (both measured in SI
units) in a MATLAB figure window using the present machine parameters.

• Plot Torque Speed (pu) plots torque versus speed (both measured in per
unit) in a MATLAB figure window using the present machine parameters.

Synchronous Machine Options

• Display Base Values displays the machine per-unit base values in the
MATLAB Command Window.

• Display Associated Base Values displays associated per-unit base
values in the MATLAB Command Window.

• Associated Initial Conditions displays associated initial conditions at
the MATLAB Command Window.
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Machine Inertia Block Options
For the Machine Inertia block, you can display the inertia parameters and
base values using the Power Systems menu on the block context menu. The
block displays parameter values in the MATLAB Command Window.
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Initialize Synchronous Machines and Controllers
In SimPowerSystems Third Generation software, you can specify steady-state
power and voltage values for a synchronous machine. Based on the values you
specify, the machine block calculates the initial field circuit and rotational
input values required to achieve this steady state. Starting a machine at
steady state prevents undesired transient effects in your simulation.

1 Calculate the required power and voltage characteristics of your load
circuit.

2 In the Initial Conditions tab of the dialog box, set Specify initialization
by to Electrical power and voltage output.

3 Enter the required power and voltage values and click OK.

4 Right-click the machine block and select Power Systems > Synchronous
Machine > Associated Initial Conditions.

SimPowerSystems calculates the field circuit and rotational port values
required to start the machine in steady state and displays them in the
MATLAB Command Window.

5 Use these values to input parameters to the blocks connected to the field
circuit and rotational ports of the synchronous machine.

Note If you set Specify initialization by to Mechanical and magnetic
states, Simulink does not calculate the machine’s associated initial
conditions.
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Three-Phase Electrical Domain
In addition to the Simscape Foundation domains, SimPowerSystems Third
Generation software contains a three-phase electrical domain. You can use
this domain to develop your own custom three-phase blocks using Simscape
language.

The three-phase electrical domain declaration is shown below.

domain electrical
% Three-Phase Electrical Domain

% Copyright 2012-2013 The MathWorks, Inc.

parameters
Temperature = { 300.15 , 'K' }; % Circuit temperature
GMIN = { 1e-12 , '1/Ohm' }; % Minimum conductance, GMIN

end

variables
V = { [ 0 0 0 ], 'V' };

end

variables(Balancing = true)
I = { [ 0 0 0 ], 'A' };

end

end

It contains the following variables and parameters:

• Across variable V (voltage), declared as a three-element row vector, in volts

• Through variable I (current), declared as a three-element row vector, in
amperes

• Parameter Temperature, specifying the circuit temperature

• Parameter GMIN, specifying minimum conductance

To refer to this domain in your custom component declarations, use the
following syntax:
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pe.electrical.three_phase.electrical

Related
Examples

• “Custom Synchronous Machine” on page 5-6

Concepts • “Customizing Machine Models” on page 5-4
• “Custom Components”
• “Foundation Domains”
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Customizing Machine Models
The ThreePhaseExamples library, included in the product examples, contains
the following custom three-phase components:

• Permanent Magnet Synchronous Motor

• Synchronous Machine

• Zigzag Transformer

You can use these simplified example models to write your own machine and
transformer component files.

To open the custom library, at the MATLAB command prompt, type
ThreePhaseExamples_lib. Double-click any block in the library to open its
dialog box, and then click the View source for BlockName link in the block
dialog box to open the Simscape source file for this block in the MATLAB
Editor.

To customize the block for your application, edit the source file and save it in
a package directory.

For example, you can create a folder called +MyMachines and save the
source files for your customized machines in this folder. Create this folder
in your working directory, or in another directory that is on the MATLAB
path. Running the ssc_build command on this package generates the
MyMachines_lib library model. This library contains all your custom machine
blocks and is located in the same directory where you have created the
+MyMachines folder. Open the MyMachines_lib library by double-clicking it
or by typing its name at the MATLAB command prompt.

For more information on packaging and deploying Simscape component files,
see “Generate Custom Block Libraries from Simscape Component Files”.

Things to keep in mind when writing component files:

• If you create a new custom component by modifying an existing one, do not
forget to change the name of the component and the name of the resulting
block.
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• The component name must be the same as the name of the Simscape
file. For example, if you plan to save your component in a file called
MyComponent.ssc, change the declaration line in the file:

component MyComponent

• The comment line immediately following the component declaration (that
is, the first line beginning with the % character) defines the name of the
block, as it appears in the custom library next to the block icon and at the
top of the block dialog box. If you do not specify this comment, then the
component name serves as the block name. The block name must be unique
within the subpackage (sublibrary) where it resides.

• Additional comments, below the line specifying the block name, are
interpreted as the block description. You do not have to modify them when
copying an existing file, but if you change the way the component works,
it makes sense to reflect the change in the block description. The block
description is for informational purposes only.

• When modifying component equations, if you introduce additional terms,
make sure to add the appropriate variables or parameters to the component
declaration section. For example, if you add zero-sequence dynamics to
the component equations, declare an additional parameter for stator
zero-sequence inductance, L0, and an additional variable for the initial
stator zero-sequence magnetic flux linkage.

The “Custom Synchronous Machine” on page 5-6 tutorial shows how you can
modify the Synchronous Machine component file and customize it for use in
your applications. For more information on writing customized component
files, see “Custom Components”.
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Custom Synchronous Machine
The ThreePhaseExamples library, included in the product examples, contains
simplified example models that you can use to write your own machine
and transformer component files. The Synchronous Machine component in
the ThreePhaseExamples library is similar to the Synchronous Machine
Round Rotor (fundamental) block, but its equations have been simplified to
omit zero-sequence dynamics. The Synchronous Machine block is therefore
suitable for balanced operation only.

This example shows how you can further simplify the component file and
make a custom machine block that does not account for the stator rate of
change of flux.

1 In your working directory, create a new folder called +MyMachines. This
folder will contain the source files for your customized machines.

2 To open the library of simplified component examples, at the MATLAB
command prompt, type:

ThreePhaseExamples_lib
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3 Double-click the Synchronous Machine block.

4 In the block dialog box, click the View source for Synchronous Machine
link.

The Simscape source file for this block opens in the MATLAB Editor.

5 Change the name of the component, the name of the block, and the block
description by replacing the first ten lines of the file:

component sm
% Synchronous Machine
% Synchronous machine (SM) with a round rotor parameterized using
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% fundamental per-unit parameters. The SM model includes field and dampe
% windings on the d-axis and two damper windings on the q-axis. The stato
% d.psi/dt terms are included, as is the effect of speed variation on the
% stator voltages. The defining equations are simplified by omitting the
% zero-sequence dynamics: the model is suitable for balanced operation.

% Copyright 2012-2013 The MathWorks, Inc.

with:

component sm1
% Simplified Synchronous Machine
% This synchronous machine does not include the stator d.psi/dt terms.

6 To remove the stator rate of change of flux terms, scroll down to the
equations section and modify the stator voltage equations from:

% Per unit stator voltage equations
pu_ed == oneOverOmega*pu_psid.der - pu_psiq*pu_velocity - Ra*pu_id;
pu_eq == oneOverOmega*pu_psiq.der + pu_psid*pu_velocity - Ra*pu_iq;

to:

% Per unit stator voltage equations
pu_ed == -pu_psiq*pu_velocity - Ra*pu_id;
pu_eq == pu_psid*pu_velocity - Ra*pu_iq;

7 Save the file in the +MyMachines folder as sm1.ssc. The name of the
Simscape file must match the component name.

8 To generate the custom library containing the new block, at the MATLAB
command prompt, type:

ssc_build MyMachines

This command generates the MyMachines_lib library model in your
working directory.
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Note Before running the ssc_build command for the first time, you must
set up your compiler by running mex -setup. For more information, see
“Build MEX-Files” in the MATLAB External Interfaces documentation.

9 To open the custom library, at the MATLAB command prompt, type:

MyMachines_lib

The library contains the Simplified Synchronous Machine block, which you
can now use in your models.

See Also ssc_build

Related
Examples

• “Generate Custom Block Libraries from Simscape Component Files”
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Concepts • “Customizing Machine Models” on page 5-4
• “Three-Phase Electrical Domain” on page 5-2
• “Custom Components”
• “Customizing the Block Name and Appearance”
• “Component Equations”
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6 Simulation and Analysis of Power Engineering Systems

Selecting a Solver for Power Engineering Systems
In SimPowerSystems Third Generation models, as with Simscape, you must
include a Solver Configuration block in each topologically distinct physical
network.

The Solver Configuration block has a local solver option. In Simscape-based
models, the local solver is a fixed-step, sample-based solver that represents
physical network states as discrete states. To use the local solver, select the
Use local solver check box in the Solver Configuration block.

For most SimPowerSystems Third Generation models, the local solver is
an appropriate choice. The local solver updates SimPowerSystems Third
Generation block states once per simulation time step, as determined by
the value of the Sample time parameter. For simulation of a 60 Hz AC
system, an appropriate sample time is a value in the order of 1e-4. Any
non-Simscape-based blocks in the model use the global Simulink solver
specified in the model configuration parameters.

You can also use the global Simulink solver instead of the local solver to solve
your physical network. To do so, clear the Use local solver check box in the
Solver Configuration block. All blocks in the model then use the Simulink
solver specified in the model configuration parameters.

For a model with only SimPowerSystems Third Generation blocks, an
appropriate Simulink solver choice is the moderately stiff solver ode23t, using
the default variable-step type. For a 60 Hz AC system, specify a value for
Max step size in the order of 1e-4.

However, you can select any of the Simulink solvers available in the model
configuration parameters. Choose a solver based on the block states and
dynamics of your overall system. Specify a solver type (variable or fixed-step)
and step size based on the simulation fidelity you want.

To learn more about making an appropriate solver choice for your simulation,
see “Simulation” in the Simscape documentation.
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Simulating Power Engineering Systems
SimPowerSystems Third Generation models are Simscape block diagrams
refined for modeling and simulating three-phase electrical power systems.
Therefore, SimPowerSystems Third Generation and Simscape simulations
behave in the same way. In addition, Simscape techniques for simulation
setup and troubleshooting apply to SimPowerSystems Third Generation
models.

To learn about:

• The simulation behavior of Simscape models, see “How Simscape
Simulation Works”.

• Techniques for finding system operating points and linearizing the
response of Simscape models, see “Trimming and Linearization”.

• Troubleshooting Simscape simulations, see “Troubleshooting”.
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